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Objectives

After completing this lab, you will be able to:

· Convert a JavaBean into a .NET Framework component.

· Convert a Java collection class into a .NET Framework collection class.

· Migrate simple JDBC data access code to ADO.NET.

· Convert an AWT user interface into a Windows Forms user interface.

Note

This lab focuses on the concepts in this module and as a result may not comply with Microsoft security recommendations.

Note

The line numbers specified in this lab are provided as a guide only. You may find that some of the line numbers vary depending on how you edit the code.

Prerequisites 
Before working on this lab, you must have:

· Experience compiling and running Java applications.

· Experience with the JDK 1.1, including the JavaBeans framework, Java collection classes, JDBC, and AWT.

Scenario

Northwind Traders have a number of legacy applications written several years ago using Java and the JDK 1.1. You have been asked to migrate one of these applications to the .NET platform. The application provides a simple GUI built using the AWT that allows a user to maintain information about products in the Northwind database (a Microsoft SQL Server™ database). The application allows the user to display and modify the name, quantity per unit, and unit price of each product. Internally, the application makes use of JavaBeans to model products, a collection that acts as a cache for these JavaBeans, and JDBC data access code to retrieve and update product information.

Estimated time to complete this lab: 120 minutes

Exercise 1
Examining the Java Application

In this exercise, you will familiarize yourself with the existing Java application.

· Build and run the Java application

1. Please Read: Due to licensing restrictions, Java software has not been installed in the Hosted Experience environment – hence, the steps in this section (“Build and run the Java application”) will not function. Instead, you should read the steps in this section to familiarize yourself with how the original Java application behaves.
2. Open a command prompt window and move to the folder C:\JavaMigration\Labs\Lab02\Starter.

3. Display the value of the CLASSPATH environment variable and ensure that it contains the archives msbase.jar, mssqlserver.jar, and msutil.jar. These archives contain the SQL Server JDBC driver and its supporting classes.

echo %CLASSPATH%

4. Compile all the Java files in the Products folder using javac:

javac Products\*.java

Note

The javac compiler will display a warning stating that the class ProductsGUI.java uses a deprecated API. This is because it is an old application that uses methods that are now out of date. You can ignore this warning.

5. Run the program:

java Products.ProductsGUI

The Products Maintenance form appears as shown below.
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6. Click Fetch. The message "Fetching" briefly appears at the bottom of the form before the first row is displayed. The message changes to "Row 1 of 77", and the Next button is enabled.
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7. Click Next. The second row will be displayed, the message changes, and the Previous button is enabled.

8. Click Previous. The first row is displayed again, and the Previous button is disabled (there is no row before row 1).

9. Click Next. The next row is displayed (the Chang product).

Note

The Next button is disabled when the last record is reached.

10. Click the Quantity Per Unit text field, and modify the text to "26 - 12 oz bottles". The Update button is enabled.

11. Click Update. A crude modal dialog box appears with the message "Changes saved". Click OK. Notice that the Update button is now disabled.

12. Click the Unit Price text field. Change the value to 200.0. Notice that any non-numeric characters that you type are ignored. Also notice that you cannot type more than 6 characters in this field.

13. Click Previous. A modal dialog box appears with the message "Changes may be lost. Continue?". The purpose of this message is to warn you that you have not saved the changes (using the Update button) and that if you move away from this row the changes will be lost. Click Yes. The first row is displayed.

14. Click Next. Notice that the Unit Price has reverted to its original value (19.0).

15. Close the application.

16. Leave the command prompt window open.

· Examine the Java code

1. Please Read: Due to licensing restrictions, Java software has not been installed in the Hosted Experience environment – hence, the steps in this section (“Examine the Java code”) will not function. Instead, you should read the steps in this section to familiarize yourself with how the original Java application behaves.
2. In the command prompt window, move to the folder C:\JavaMigration\Labs\Lab02\Starter\Products.

3. Using Notepad, examine each of the Java files in turn. The following table briefly summarizes the purpose of each class.

	Class
	Description

	

	ProductBean
	JavaBean modeling a Product from the Northwind database. Exposes the ProductId (read-only), ProductName, QuantityPerUnit, and UnitPrice columns as properties. The saveChanges method uses JDBC to save any changes to the bean back to the Northwind database. The discardChanges method (not actually used by the application) repopulates the bean from the database discarding any changes made. The bean exposes two events—savedEvent and saveFailedEvent triggered by the saveChanges method. Event subscribers are held in two private vectors, and manipulated using the add/remove methods for each event. 

	SavedEvent and SaveFailedEvent
	Event state classes for the two events raised by ProductBean. SavedEvent does not actually have any state information. SaveFailedEvent holds a string containing a message indicating why the save operation failed. 

	SavedEventListener and SaveFailedEventListener
	Interfaces that define the methods that classes subscribing to the savedEvent and saveFailedEvent must implement.

	SavedEventHandler and SaveFailedEventHandler
	Classes that implement the event listener interfaces. Both methods simply display a modal dialog box containing a message stating that the save operation was successful or that it failed (together with the reason for the failure).

	MsgDialog
	A modal AWT Frame that displays a message (passed into the constructor), and an OK button. Used by the event handler methods and the ProductsGUI class (see later).

	QueryDialog
	Another modal AWT Frame that displays a message (passed into the constructor) with Yes and No buttons. The YesSelected property returns true if the user clicks Yes, false otherwise.

	DataBeanCollection
	A collection class (based on ArrayList) for caching ProductBean objects. The class exposes the fill method that retrieves all Product rows from the Northwind database, creates and populates ProductBeans, and adds them to the collection.

	DatabaseUtils
	A class containing static utility methods and properties for managing JDBC connections to SQL Server.

	ProductsGUI
	The user interface, created using AWT. Displays four fields (Product Id, Product Name, Quantity Per Unit, Unit Price) and buttons (Fetch, Next, Previous, Update). Buttons are enabled and disabled dynamically according to the state of the UI. Uses a DataBeanCollection object to cache ProductBean objects.


Log in to the
Hosted Experience

The Visual Studio Hosted Experience is pre-configured to allow you to run the following lab in a hosted environment. A broadband connection is required. 

· Log in to the Hosted Experience

1. Open Internet Explorer.
2. Browse to http://msdn.microsoft.com/virtuallab. 

3. Click on the lab group titled “Java to .NET Framework Migration Workshop.”

4. Click on the lab titled “Manually Migrating J2SE Application Code.”

5. Follow the remaining on-screen instructions to start the Virtual Lab experience. Once you have logged in and started the Virtual Lab session you may begin with Exercise 2.

Exercise 2
Converting J2SE Code to C#

In this exercise, you will map the Java classes to the equivalent 
.NET Framework technologies, and then convert the application to C#.

Tip

Completed code for the C# classes in this exercise are available in the C:\JavaMigration\Labs\Lab02\Solution\Products.NET folder.

· Specify an appropriate mapping of technologies

· The following table summarizes the most appropriate way to map the technologies used by the Java application to the .NET Framework. You will follow this strategy in the lab exercises. Note that although there is no such thing as a 'bean' in C#, you will maintain the same naming conventions for the classes and source file names to maintain consistency throughout the migration process.
	Java technology
	Mapped to

	

	ProductBean
	Convert to a .NET Framework component exposing .NET style properties. Implement the events using .NET delegates and discard the event listener interfaces. Use the SQL Server ADO.NET provider for data access.

	SavedEvent, SaveFailedEvent, SavedEventHandler, SaveFailedEventHandler, SavedEventListener and SaveFailedEventListener
	Remove these classes and interfaces. The .NET Framework implements classes using its own delegated methods and event objects which will be added to the migrated ProductBean class.

	DatabaseUtils
	Re-implement using ADO.NET.

	DataBeanCollection
	Convert to a .NET Framework ArrayList. Use ADO.NET for data access. Discard the event handler classes and implement as delegated methods in this class instead ().

	MsgDialog and QueryDialog
	Remove these classes. Use System.Windows.Forms.MessageBox for displaying dialog boxes rather than creating new windows manually.


	ProductsGUI
	Re-implement using Windows Forms. Convert application logic in event handlers for the buttons and text fields into C#.


· Create the C# Project

4. On the Start menu, point to All Programs, point to Microsoft Visual Studio .NET 2003, and click Microsoft Visual Studio .NET 2003. The Microsoft Visual Studio IDE appears.

5. On the File menu, point to New, and then click Project.

6. In the New Project dialog box, click Visual C# Projects in the Project Types tree, click Windows Application in the Templates pane, type Products.NET for the Name, and type C:\JavaMigration\Labs\Lab02 for the Location. Click OK.

The new project is created. The Solution Explorer displays the source files that comprise the application, and the design window displays a blank Windows form entitled Form1.
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· Re-implement the ProductsGUI class using Windows Forms

In this step you will build the ProductsGUI, working from a partially built source file. Note that you will add further functionality to the interface later in the lab.
1. In the Solution Explorer, right-click Form1.cs, click Delete, and then OK.
2. On the Project menu, click Add Existing Item, and then add the following source file to the solution:

C:\JavaMigration\Labs\Lab02\Starter\Prebuilt\ProductsGUI.cs
3. In Solution Explorer, double-click ProductsGUI.cs. The form appears as follows:
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Note

Notice that the following components are missing from the form: Quantity Per Unit label and text box, Unit Price label and text box, Update button.
4. Right-click the form background, and click View Code. Notice the following code items:
· Four private variables are declared to hold a copy of the DataBeanCollection, the current productbean being displayed, the current productbean id and a flag to indicate whether any updates have been made, parentWindow is used to hold a reference to the ProductGUI form which is passed to child forms:
private DataBeanCollection products;

private ProductBean current;

private int currentIndex;

private bool rowEdited = false;
public static Frame parentWindow;

· The Dispose() pattern is implemented as follows to enable the disposal of components contained within the form. Note that this code is automatically created by Visual Studio.

protected override void Dispose( bool disposing )

{


if( disposing )


{



if (components != null) 



{




components.Dispose();



}


}


base.Dispose( disposing );

}

· The CheckForUpdates() method provides a simple MessageBox asking if the user wishes to save changes before moving away from a particular product:

private bool CheckForUpdates()

{


if (this.rowEdited)


{



return (MessageBox.Show(parentWindow,



"Changes may be lost. Continue?",



"Products Maintenance",



MessageBoxButtons.YesNo,



MessageBoxIcon.Question)



== DialogResult.Yes);


}


return true;

}
Note

The MessageBox.Show method can display multiple buttons, such as "Yes" and "No". The value returned by the method indicates which button the user clicked to dismiss the dialog box.

· The following event handling methods are provided for you: CheckForUpdates(),TextQuantityPerUnit_KeyPress(),TextProductName_KeyPress(),PrevButton_Click(), FetchButton_Click()
· You will add code to the following method stubs: DoFetch(), DisplayProduct(),TextUnitPrice_KeyPress(), NextButton_Click()
5. Locate the code region marked Windows Form Designer generated code. Click the adjacent + sign. Notice that the code region contains code that sets the properties of the controls. You can also write your own code to set and read the values of control properties.

6. Click the – sign by the statement #region Windows Form Designer generated code to contract the code region.

Important

Do not change the code in this region. It is maintained automatically by the forms designer, and any changes you make may be lost whenever you switch back to the design view of the form, or make the code unusable by the form designer.

7. View the form in design mode.
8. From the Toolbox, add a Label control to the form, and set its properties in the Properties window, using the values in the table below: 

	Property
	Value

	

	Text
	Quantity Per Unit:

	Location
	24, 80


9. Add another Label control to the form, and set its properties using the values in the table below: 

	Property
	Value

	

	Text
	Unit Price:

	Location
	24, 112


10. Using the Toolbox, click and drag a TextBox control onto the form. Set its properties using the values in the table below:

	Property
	Value

	

	(Name)
	textQuantityPerUnit

	Enabled
	False

	Location
	136, 80

	Size
	160, 20

	Text
	Blank this out


11. Copy the text box that you have just created, and then paste it back onto the form. Align it with the other text boxes. Change the properties of the text box as follows:
	Property
	Value

	

	(Name)
	textUnitPrice

	MaxLength
	6


Note

The MaxLength property specifies the maximum number of characters the user can type into the text box. In the AWT version of this form, this functionality was provided by trapping the keyPressed event and examining how many characters the text box contained, rejecting the key press if there were already 6 characters in the text box.

12. Add a final Button control onto the form. Set its properties using the values in the table below:

	Property
	Value

	

	(Name)
	updateButton

	Enabled
	False

	Location
	232, 160

	Size
	64, 23

	Text
	Update


The completed form should look like the following image.
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13. In the Task List, right-click the background, point to Show Tasks, and then click Comment.

14. In the Task List, double-click TODO: Assign this to parentWindow.
15. Delete the //TODO: comment and add the following code statement after the call to the InitializeComponent method call:

parentWindow = this;

16. In the Task List, double-click TODO: Add code to display a product.
17. Delete the //TODO: comment and add the following code to assign the values from the current ProductBean to the Text properties of the relevant text box controls:

this.textProductId.Text = 






Convert.ToString(current.ProductId);

this.textProductName.Text = current.ProductName;

this.textQuantityPerUnit.Text = current.QuantityPerUnit;

this.textUnitPrice.Text =






Convert.ToString(current.UnitPrice);

this.rowEdited = false;

18. Display the ProductsGUI form in the form designer window—click the ProductsGUI.cs[Design] tab above the window currently displaying the code.

19. Select the textUnitPrice text box. Click the Events button (displaying the lightning bolt icon) in the Properties window. A list of available events for this text box will be displayed. In the KeyPress event, select TextUnitPrice_KeyPress (A stub method provided for you in the starter file). 

20. In the Task List, double-click TODO: Add keypress handling code.
21. Delete the //TODO: comment and add the following code to control user input to the TextUnitPrice text box:
char c = e.KeyChar;

if  (! ((c == 8) ||



(c == '.') ||


    (Char.IsNumber(c))))

{


e.Handled = true;

}

this.rowEdited = true;

updateButton.Enabled = true;
Note

Like the Java event handler, the parameter to the .NET Framework event handler (variable e) contains information about the key that was pressed. This key is available using the KeyChar property.
The event handler method is part of the ProductsGUI class, so the reference to rowEdited can be qualified using this. In the original Java code, the event handler was implemented using an anonymous class, so this would have referred to the anonymous class instead.

22. Repeat step 19 for the textQuantityPerUnit text box, setting the KeyPress event to invoke the TextQuantityPerUnit_KeyPress event handler. In this case, the handler has been written for you.
23. In the Task List, double-click TODO: Add code to create and populate a DataBeanCollection object.

24. Delete the //TODO: comment and add the following code to populate the DataBeanCollection object list:
try

{


DataBeanCollection list = new 



DataBeanCollection();


list.fill();


return list;

}

catch(Exception e)

{


throw e;

}
Note

You will created the DataBeanCollection class later in the lab.

25. In the Task List, double-click TODO: Add code to populate DataBeanCollection Object
26. Delete the //TODO: comment and add the following code inside the try block to retrieve all products and populate the current ProductBean:
products = DoFetch();

lblStatus.Text = "Row 1 of " + products.Count;

currentIndex = 0;

current = (ProductBean)products[currentIndex];

DisplayProduct();

nextButton.Enabled = true;

prevButton.Enabled = false;

updateButton.Enabled = false;

textProductName.Enabled = true;

textQuantityPerUnit.Enabled = true;

textUnitPrice.Enabled = true;

27. Display the ProductsGUI form in the form designer window. Double-click the Update button. An event handler named UpdateButton_Click is created.

28. In the UpdateButton_Click event handler, add the following code to transfer the values from the form into the current ProductBean:
current.ProductName = textProductName.Text;

current.QuantityPerUnit = textQuantityPerUnit.Text;

current.UnitPrice =





Convert.ToSingle(textUnitPrice.Text);

if (current.saveChanges())

{


this.rowEdited = false;


updateButton.Enabled = false;

}

29. In the Task List, double-click TODO: Add code to get next product
30. Delete the //TODO: comment and add the following code to retrieve the next ProductBean from the products collection and display it in the form:
if (CheckForUpdates())

{


currentIndex++;


current = 



(ProductBean)products[currentIndex];


lblStatus.Text = "Row " + (currentIndex + 1) 



+ " of " + products.Count;


DisplayProduct();


updateButton.Enabled = false;


prevButton.Enabled = true;


if (currentIndex == products.Count - 1)


{



nextButton.Enabled = false;


}

}
31. In the Task List, double-click TODO: Add Main method.
32. Delete the //TODO: comment and add the following code to create a Main method to invoke the Windows application:
[STAThread]

static void Main() 

{


Application.Run(new ProductsGUI());

}
6. Build the solution. The following 3 errors are displayed. These will be resolved when you build the additional components later in the lab.

C:\JavaMigration\Labs\Lab02\Products.NET\ProductsGUI.cs(227): The type or namespace name 'DataBeanCollection' could not be found (are you missing a using directive or an assembly reference?)

C:\JavaMigration\Labs\Lab02\Products.NET\ProductsGUI.cs(19): The type or namespace name 'DataBeanCollection' could not be found (are you missing a using directive or an assembly reference?)

C:\JavaMigration\Labs\Lab02\Products.NET\ProductsGUI.cs(20): The type or namespace name 'ProductBean' could not be found (are you missing a using directive or an assembly reference?)

· Re-implement the DatabaseUtils class using ADO.NET

In this section, rather than building the utility class from scratch, you will start off using a pre-built class.

7. On the Project menu, click Add Existing Item.

8. In the Add Existing Item dialog box, browse to the following location:
C:\JavaMigration\Labs\Lab02\Starter\Prebuilt.
9. Click DatabaseUtils.cs, and then click Open.

10. In Solution Explorer, right-click DatabaseUtils.cs, and then click View Code.

11. Notice the following:

· The System and System.Data.SqlClient namespaces are imported. The System.Data.SqlClient namespace contains the ADO.NET classes for the SQL Server provider. For example:
using System;

using System.Data.SqlClient;
· The DatabaseUtils class is part of the Products namespace. Namespaces provide logical grouping of classes (similar to the notion of a package in Java):
namespace Products

{

   …

}

· A number of static fields are used to define connection settings:
private static SqlConnection con = null;

private static String serverName = "localhost";

private static String databaseName = "Northwind";

private static String userName = "user";

private static String password = "password";

· A number of static properties are defined to facilitate access to the static fields. For example:
// Public properties

public static String ServerName

{


get


{



return serverName;


}


set


{



serverName = value;


}

}

12. Towards the bottom edge of Visual Studio, click the Task List tab, and then right-click the Task List pane, point to Show Tasks, and then click All.

13. In the Task List, double-click TODO: Add read/write UserName property.
14. Delete the //TODO: comment, and then add the following code to create a UserName property:
public static String UserName

{


get


{



return userName;


}


set


{



userName = value;


}

}

15. In the Task List, double-click TODO: Add connection code.

16. Delete the //TODO: comment, and then add the following code to the GetConnection method:
con = new SqlConnection(ConnectionString +



  ";User ID=" + userName +



  ";Password=" + password);

con.Open();

return con;

17. In the Task List, double-click TODO: Close connection.

18. Delete the //TODO: comment, and then add the following code to the CloseConnection method:
if(con != null)


con.Close();

con = null;

· Convert the ProductBean class

1. On the Project menu, click Add Class.

2. In the Add New Item dialog box, ensure the Class template is selected, type ProductBean.cs for the Name, and then click Open. 

The class is created, added to the Solution Explorer, and displayed in the code view window.
3. Return to the command prompt window in the Products folder. Open the file ProductBean.java using Notepad. Select all the code in this file and paste it into the ProductBean class displayed in Visual Studio overwriting all the existing code. Close Notepad.

4. In Visual Studio, at the top of the ProductBean class, change the package statement into a namespace statement (removing the semi-colon) and add an opening brace and a matching closing brace at the end of the class (the implementation of the ProductBean class should be within the braces.) Change the import statements into using statements, as shown below. Note that the convention in a C# application is to place using statements before the namespace statement:

using System;

using System.Data.SqlClient;

namespace Products

{

    ProductBean implementation

}

5. Locate the three private final String variable declarations for the database connection properties (serverName, username, and password), and change the final keyword to const for each of them as follows:

// Database connection properties. Edit as necessary

private const String serverName = "localhost";

private const String userName = "user";

private const String password = "password";

6. Locate the getProductId property accessor method. Change it into a .NET Framework read-only property named ProductId:

public int ProductId

{


get


{



return this.id;


}

}

Note

Properties in the .NET Framework comprise a declaration specifying the name of the property, its type, and explicit get and set accessors (as appropriate), rather than a pair of getXXX and setXXX methods.

7. Change the getProductName and setProductName property accessor methods in a read/write .NET Framework property named ProductName:

public String ProductName

{


get


{



return this.name;


}


set


{



this.name = value;


}

}

Note

The set accessor does not require a parameter, unlike a Java setXXX property accessor method. Instead, the value keyword in C# denotes the value being assigned to the property at runtime.

8. Using the same approach, change the getQuantityPerUnit and setQuantityPerUnit methods into a .NET Framework String property called QuantityPerUnit.

9. Change the getUnitPrice and setUnitPrice methods into a .NET Framework float property called UnitPrice.

10. Locate the saveChanges method. This is the method that currently connects to SQL Server using JDBC and executes an SQL UPDATE statement to save the contents of the bean back to the database. The method fires the savedEvent if the operation is successful, and the saveFailedEvent if not. Change the type of the method from boolean to bool.

11. In the saveChanges method, change the statements that set the database parameters as shown below:

// Set database connection parameters

DatabaseUtils.ServerName = serverName;

DatabaseUtils.UserName = userName;

DatabaseUtils.Password = password;
Note

Take advantage of IntelliSense by deleting each line back to DatabaseUtils, then type a ".". You can then select the appropriate public member, press TAB, and then continue typing. Notice also that you can auto-complete variables, objects and public methods etc by partially typing the name and then pressing CONTROL+SPACEBAR.
12. Change the definition of the con variable into a SqlConnection object:

SqlConnection con = null;

13. In the try block that follows, change the getConnection method call into a statement that invokes the GetConnection method of the DatabaseUtils class:

con = DatabaseUtils.GetConnection();

14. In the next try block, locate the code that updates the database. Change the statements that create the JDBC Statement object, and the calls to the JDBC methods executeUpdate and close to ADO.NET method calls. Note that the CloseConnection method has a capital 'C':

SqlCommand stmt = con.CreateCommand();

stmt.CommandText = updateStatement;

stmt.ExecuteNonQuery();

stmt.Dispose();
DatabaseUtils.CloseConnection();

Note

The SQL Server ADO.NET provider has the SqlCommand type with several properties, including CommandText which contains an SQL statement to execute, and methods such as ExecuteNonQuery which is used to run SQL operations that do not return rows from the database. The SqlCommand class does not have a close method, you can use Dispose() instead.
15. Locate the discardChanges method. This method also uses JDBC to retrieve the data for the product identified by the id variable (exposed by the ProductId property) into the other variables in the bean.

16. Remove the throws Exception  clause from the declaration of the discardChanges method:

public void discardChanges()

Note

C# does not support checked exceptions.
17. Update the three statements that set the connection parameters for the database, as described in step 11 (you can simply copy and paste your previous code):

DatabaseUtils.ServerName = serverName;

DatabaseUtils.UserName = userName;

DatabaseUtils.Password = password;

18. Change the definition of the con variable, as described in step 12:

SqlConnection con = null;

19. In the first try block, change the getConnection method call as described in step 13:
con = DatabaseUtils.GetConnection();

20. In the second try block, replace the two statements that create a JDBC Statement and a ResultSet object with the following code:

SqlCommand stmt = con.CreateCommand();

stmt.CommandText = queryStatement;

SqlDataReader rs = stmt.ExecuteReader();

Note

The SQL Server ADO.NET SqlCommand class has the ExecuteReader method for executing SQL SELECT statements and returns a SqlDataReader object for iterating through the results.

21. To ensure efficient disposal of the SqlDataReader object, enclose the SqlDataReader (that you created in the last step) in a using block as follows:
using(SqlDataReader rs = stmt.ExecuteReader())

{


Note

The using statement specifies the scope of the specified object. Note that the specified object (SqlDataReader in this case) must implement the System.IDisposable interface. Once the end of the using block is reached, the Dispose() method is automatically invoked on the scoped object.
22. Add a closing brace after the else block as follows:

else


{



throw new Exception("product deleted");


}

}

23. Change the if statement that fetches the first row of the results:

if (rs.Read())

Note

The Read method of a SqlDataReader object retrieves the next row from the result set, returning true if a row was successfully retrieved, false otherwise (just like the next method of the JDBC ResultSet class).

24. Change the block of code that populates the variables in the ProductBean object using the data in the current row:

{


this.name = Convert.ToString( rs["ProductName"]);


this.qty = Convert.ToString(rs["QuantityPerUnit"]);


this.price = Convert.ToSingle(rs["UnitPrice"]);

}

Note

You access the fields in the current row returned by a SqlDataReader using array notation. The Convert class in the .NET Framework contains a variety of methods for converting data betweendifferent formats—the ToSingle method converts data into a float.

25. After the else block, remove the rs.close() method call as this is taken care of by the using block.
26. Change the stmt.close() and closeConnection() as follows:
stmt.Dispose();

DatabaseUtils.CloseConnection();

27. After the discardChanges method, locate the definitions of the savedListeners and saveFailedListeners variables. These two variables are used by the Java event handling code to record subscribers to the two events. The .NET Framework uses a different, simpler technique. Therefore these two variables are redundant so delete them and replace them with the following items:

public delegate void savedDelegate();

public event savedDelegate savedEvent;

public delegate void saveFailedDelegate(Exception e);

public event saveFailedDelegate saveFailedEvent;

Note

The .NET Framework has its own event type. An event is defined in terms of a delegate, which specifies the signature that a subscribing method must adhere to, in a manner similar to the event listener interfaces of the Java event model. Subscribers to savedEvent must supply a method that takes no parameters, and subscribers to the saveFailedEvent must supply a method that takes an Exception object as a parameter.

28. Locate the fireSavedEvent method. Much of the code in this method is concerned with iterating through the subscribers to the event and invoking the event handler for each one. This code is not required by .NET Framework applications. Replace the body of the fireSaved event as shown below:

private void fireSavedEvent()

{


if (this.savedEvent != null)



this.savedEvent();

}

Note

To raise a .NET Framework event, simply invoke the event object in the same way as calling a method. The common language runtime will automatically locate all subscribers and call their subscribing methods.

29. Replace the body of the fireSaveFailedEvent in a similar manner, with a single statement that invokes this.saveFailedEvent but passing it the Exception object passed to the fireSaveFailedEvent—subscribers must supply a method that takes a single Exception object:


private void fireSaveFailedEvent(Exception e)


{


if (this.saveFailedEvent != null)




this.saveFailedEvent(e);


}

30. The methods addSavedEventListener, addSaveFailedEventListener, removeSavedEventListener, and removeSaveFailedEventListener are no longer needed so delete them. 

Note

The .NET Framework provides an easier way to subscribe to events that you will see later.

· Convert the DataBeanCollection class

1. Using the Project menu, add another Class to the project called DataBeanCollection.cs.
2. Using Notepad, copy and the contents of the file DataBeanCollection.java into the DataBeanCollection class in Visual Studio, overwriting the existing code.

3. In the DataBeanCollection class in Visual Studio, replace the package and import statements with namespace and using statements, as shown below:

using System;

using System.Data.SqlClient;

using System.Windows.Forms;

using System.Collections;

namespace Products

{

    ...

}

Note

The System.Windows.Forms namespace contains the classes used for building Windows user interfaces—analogous to java.awt.*. The System.Collections namespace contains the .NET Framework collection classes.

4. Change the definition of the DataBeanCollection class. Remove the extends keyword and replace it with a colon (:):

public class DataBeanCollection: ArrayList

Note

The colon is used to indicate both extends and implements. The list that follows can be a comma separated list comprising at most one class, but any number of interfaces. It is conventional to place the class first in this list. Note also that we're extending ArrayList soley out of expediency; a full implementation would compose the ArrayList and then expose appropriate Add, Remove methods.
5. In the DataBeanCollection class, replace the keyword final in the definitions of the serverName, username, and password variables with const.

6. Remove the throws Exception clause from the definition of the fill method.

7. In the fill method, change the method call this.clear() to this.Clear().

8. Replace the method calls to DatabaseUtils.setServerName, DatabaseUtils.setUserName, and DatabaseUtils.setPassword with references to the appropriate properties instead.

9. Change the declaration of the con variable to be a SqlConnection object.

10. In the first try block, change the DatabaseUtils.getConnection method call to reference the GetConnection() method of the DatabaseUtils class.

11. In the second try block, replace the two statements that create a JDBC Statement and a ResultSet object with the following code:

SqlCommand stmt = con.CreateCommand();

stmt.CommandText = queryStatement;

SqlDataReader rs = stmt.ExecuteReader();

12. As before, place the SqlDataReader object in a using statement as follows:
using(SqlDataReader rs = stmt.ExecuteReader())

{

13. Place a closing brace after the while block as follows:


// Subscribe to the events published by the ProductBean


pb.addSavedEventListener(new SavedEventHandler());


pb.addSaveFailedEventListener(new 



SaveFailedEventHandler());


}

}

14. Change the while statement that fetches the results:

while (rs.Read())

15. Change the block of code (first 5 lines of code within while loop) that creates and populates a new ProductBean object using the data in the current row:

{



int id = Convert.ToInt32(rs["ProductID"]);


ProductBean pb = new ProductBean(id);


pb.ProductName = 





Convert.ToString(rs["ProductName"]);


pb.QuantityPerUnit = 





Convert.ToString(rs["QuantityPerUnit"]);


pb.UnitPrice = Convert.ToSingle(rs["UnitPrice"]);

16. Change the call to this.add(pb) to this.Add(pb).

17. Replace the statements that subscribe to the Java savedEvent and saveFailedEvent with the following code:

pb.savedEvent += new ProductBean.savedDelegate






(this.handleSavedEvent);

pb.saveFailedEvent += 
new ProductBean.saveFailedDelegate







(this.handleSaveFailedEvent);

Note

To subscribe to a .NET Framework event, create a delegate that refers to a method to be called when the event is fired, and simply add this delegate to the event. Internally a .NET Framework event maintains a list of all delegated methods. When the event is fired, each subscribing method will be called. You will create the handleSavedEvent and handleSaveFailedEvent methods later in this procedure.

18. After the using block, remove the rs.close() method call as this is taken care of by the using block.

19. Change the stmt.close(); statement to:

stmt.Dispose();
20. Change the DatabaseUtils.closeConnection() statement to:

DatabaseUtils.CloseConnection();

21. Add the following method to the DataBeanCollection class. This is the method invoked by the savedEvent. It displays the "Changes saved" message in a dialog box (and echoes the message to the standard error stream, Console.Error which is analogous to System.err). The dialog box is modal with respect to the window specified by the ProductsGUI.parentWindow variable (you will create this class in the next procedure):

// Event handling methods

public void handleSavedEvent()

{


Console.Error.WriteLine("Changes saved");


MessageBox.Show(ProductsGUI.parentWindow, 






 "Changes saved", 






 "Products Maintenance", 






 MessageBoxButtons.OK,






 MessageBoxIcon.Information);

}

Note

The System.Windows.Forms.MessageBox.Show method displays a dialog box with the specified message, title, buttons, and icon. The MessageBox class removes the need for the MsgDialog and QueryDialog classes defined by the original Java application.

22. Add the following method to the DataBeanCollection class. This is the method invoked by the saveFailedEvent. This method displays the information passed in by the Exception parameter in a dialog box:

public void handleSaveFailedEvent(Exception sfe)

{


Console.Error.WriteLine("Save failed: " +








  sfe.Message);


MessageBox.Show(ProductsGUI.parentWindow,






 sfe.Message, 






 "Products Maintenance",






 MessageBoxButtons.OK,






 MessageBoxIcon.Error);

}

· Build and run the migrated application

1. Build the solution. The application should compile without any errors—correct any errors that occur before continuing.

2. On the Debug menu, click Start. The application should start running. Verify that you can fetch and update products as before. Close the application when you have finished.

Note

The compiled application is called Products.NET.exe, and is placed in the folder C:\JavaMigration\Labs\Lab02\Products.NET\bin\Debug. You can also execute it outside of Visual Studio in the same manner as any other Windows application—by double-clicking the file using Windows Explorer, or by typing its name in a command prompt window. Unlike Java applications which require you to use the java command to run the JVM, you do not need to explicitly start the CLR to run a .NET Framework application.







